SELECTION .................................................................................................................. 19
VIEWS .......................................................................................................................... 20
LAYOUT .......................................................................................................................... 21
ADD OR REMOVE ........................................................................................................ 21
DOCUMENT TEXT ......................................................................................................... 21
ANTIALIASING .............................................................................................................. 22

EDIT TAB ....................................................................................................................... 22
TUPLES ............................................................................................................................ 22
NOTE TYPE .................................................................................................................... 23
ACCIDENTALS ............................................................................................................... 23
CLEF ................................................................................................................................. 24
CROSS STAFF ............................................................................................................... 24
PARTS ............................................................................................................................... 25
STAFF GROUPS .............................................................................................................. 25

OPERATIONS TAB ....................................................................................................... 26
COPY & PASTE ................................................................................................................ 26
VELOCITY & TRANPOSE ............................................................................................... 27
TEMPO ............................................................................................................................. 28

REPEATS & BARLINES TAB ......................................................................................... 28
SIMPLE REPEATS ......................................................................................................... 28
SPECIAL REPEATS ....................................................................................................... 29
BARLINES ....................................................................................................................... 29

DYNAMICS TAB ............................................................................................................. 29
SYMBOL OPTIONS ....................................................................................................... 30
SPECIAL ........................................................................................................................... 30
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>NETWORK TAB</td>
<td>32</td>
</tr>
<tr>
<td>Community</td>
<td>33</td>
</tr>
<tr>
<td>MIXER</td>
<td>33</td>
</tr>
<tr>
<td>Master Controls</td>
<td>34</td>
</tr>
<tr>
<td>Track Controls</td>
<td>35</td>
</tr>
<tr>
<td>Track Settings</td>
<td>35</td>
</tr>
<tr>
<td>MIDI SCRUBBING</td>
<td>36</td>
</tr>
<tr>
<td>Toggle the Midi Scrubbing Mode</td>
<td>37</td>
</tr>
<tr>
<td>Playbar</td>
<td>38</td>
</tr>
<tr>
<td>Use Cases</td>
<td>38</td>
</tr>
<tr>
<td>HISTORY VIEW</td>
<td>38</td>
</tr>
<tr>
<td>What Objects can be Undone?</td>
<td>39</td>
</tr>
<tr>
<td>What Operations can be Undone?</td>
<td>39</td>
</tr>
<tr>
<td>What is not Affected in an Undo?</td>
<td>39</td>
</tr>
<tr>
<td>Undo History Limits</td>
<td>39</td>
</tr>
<tr>
<td>COMMENT VIEW</td>
<td>40</td>
</tr>
<tr>
<td>Real Time</td>
<td>40</td>
</tr>
<tr>
<td>Character Limits</td>
<td>40</td>
</tr>
<tr>
<td>Deleting Comments</td>
<td>41</td>
</tr>
<tr>
<td>Communicating with Users</td>
<td>41</td>
</tr>
<tr>
<td>MEASURE AND SYSTEM CONTROL</td>
<td>41</td>
</tr>
<tr>
<td>Measures per Page</td>
<td>41</td>
</tr>
<tr>
<td>Systems per Page</td>
<td>42</td>
</tr>
<tr>
<td>Scope</td>
<td>42</td>
</tr>
</tbody>
</table>
ADD OR REMOVE MEASURES ................................................................. 42
  INSERT ................................................................................................ 42
  REMOVE ............................................................................................ 43

ADD OR REMOVE STAVES ................................................................. 43
  INSERT ................................................................................................ 43
  REMOVE ............................................................................................ 43

TUPLETS ............................................................................................. 44
  ACCESSING THE TUPLET RATIO DIALOG ........................................ 44
  Tuplet Options .................................................................................. 45
  Common Tuplets .............................................................................. 46
  Uncommon Tuplets ......................................................................... 46

TIME & KEY SIGNATURE ..................................................................... 47

ADDING A CLEF ................................................................................ 48

UPDATE VELOCITY ............................................................................ 49
  Specify Measure/Staves .................................................................... 50
  Partial Selection ............................................................................... 50
  Velocity Value ................................................................................ 51
  Modes ............................................................................................... 51
  Updating Individual Notes ............................................................... 51

TRANSPOSE NOTES ........................................................................... 52
  Specify Measure/Staves .................................................................... 53
  Partial Selection ............................................................................... 54
  Transpose Values ............................................................................ 54
  Shortcut ............................................................................................ 54
# Table of Contents

**MASTER TEMPO** ........................................................................................................... 54

**REALISTIC PLAYBACK** .................................................................................................. 56
- Application .................................................................................................................. 56
- Realistic Playback Metric Values ................................................................................. 58
- Metrics ......................................................................................................................... 58

**SIMPLE REPEATS** ....................................................................................................... 59
- How to Add a Repeat ................................................................................................... 59
- Adding Multiple Repeats, Implementation Diagram .................................................. 59
- Adding Ranged Repeats, Implementation Diagram ...................................................... 60
- Removing Repeats ....................................................................................................... 61

**MULTIPLE ENDINGS** .................................................................................................... 61
- How to Add a Multiple Ending .................................................................................... 61
- Adding Multiple Endings, Implementation Diagram .................................................. 61
- Removing an Ending ..................................................................................................... 62

**DA CAPO** ..................................................................................................................... 62
- Selecting D.C. Normal .................................................................................................. 62
- Implementation Diagram ............................................................................................. 63
- Removing Da Capo al Fine ............................................................................................ 63

**DA CAPO AL FINE** ....................................................................................................... 63
- Selecting D.C. al Fine .................................................................................................... 63
- Implementation Diagram ............................................................................................. 63
- Removing Da Capo al Fine ............................................................................................ 64

**DA CAPO AL CODA** ..................................................................................................... 64
- Selecting D.C. al Coda .................................................................................................. 64
INTRODUCTION

This manual outlines all the intricacies of Music Jotter including how to activate the product, common shortcuts, and what actions can be accomplished using the software.

The following manual can also be viewed on the Music Jotter website at http://www.musicjotter.com/docs/

Your Music Jotter Key is located on the front of the Music Jotter CD case. Please validate your copy of Music Jotter by visiting https://www.youngcomposers.com/mj/validate/

Upon opening Music Jotter for the first time, you will see the following dialog box:

![The dialog box to log into Music Jotter](Image)

The dialog box to log into Music Jotter
You will only be required to be connected to the internet and log in for the first time using your Young Composers username and password. Once logged in, Music Jotter will remember your credentials, unless you change computers. If you happen to change computers, you must contact the site administrator by clicking the “Click Here” button easily discernible on the Log In dialog page, and the administrator will handle the issue right away.

You will know your account has been activated once you see the Young Composers dashboard, and at the top right hand corner you will see your notifications, messages and profile link. The notifications and messages alert you in Music Jotter if someone from the Young Composers forum has sent you a message.

**KEY SHORTCUTS**

Listed are all of the shortcuts available to Music Jotter. Please note, that because there is no right click menu, the right click serves the purpose of deleting notes, removing measures, or highlighting a selection.

**Common Shortcuts**

**Notes/Rests/Symbols**

Hover over note/rest/symbol, single click to view settings

**Cross Staff**

Press and hold *Shift* while adding/editing the note pitch to cross staff either up or down

**Delete Note/Rest/Symbol**

✓ Hover over object, click right mouse button
✓ Highlight measure(s)/staff/staves, press “delete” key
✓ Multi select objects, press “delete” key

**Undo/Redo**

✓ You can undo/redo notes, rests, dynamics and measure deletions. You cannot undo key signatures, clef changes, measure size or staff deletions.
✓ Ctrl Z to undo
✓ Ctrl Y or Ctrl Shift Z to redo

Toggle “Music Scrub” Mode

Z, then left click on score and drag playbar

Playback

✓ With arrow cursor, hover over measure and press Space
✓ With arrow cursor, highlight measure, and press Space to always play from highlighted measure wherever you are within the score
✓ Tip: Click off of any measure to break highlight, to stop playing from that measure
✓ Tip: Press Up Arrow, Down Arrow while playing in order to cycle through staves that might be playing off-screen

Highlighting a Measure with the Arrow Cursor

Highlight Multi Measures/Staves

✓ Click on the Measure Select icon, located on any ribbon tab
✓ Click first measure/staff with arrow cursor, press and hold Shift, click final measure/staff to complete the range
✓ Tip: Ctrl A expands selected measures/staves to the whole page

+/- Systems (Affects Layout Only)

Up/Down arrow

+/- Measures (Affects Layout Only)

Left/Right arrow

+/- Measures (Changes number of measures in score)

✓ Left Double Click any measure to increase the measure count of the score
✓ Right Double Click an empty measure to decrease the measure count of the score
Copy/Paste

✅ Click a measure you wish to copy and press Ctrl C to copy. Then click a measure you wish to paste and press Ctrl V to paste to target measure.

✅ Tip: Paste a pattern of currently copied measures/staves by highlighting a range of measures/staves, then press Ctrl V to paste.

Multi Select Notes

Multi Note/Rest/Dynamic Selection

✅ Because the following shortcuts rely on partial selection, you can select objects by clicking on the Measure Select tool located on every ribbon menu

✅ To multi select, Left or Right Click and drag rubber band over desired objects (you may select notes, rests or dynamics this way)

+/− Transpose

With selected notes, press Up/Down arrow

Copy/Paste

✅ Ctrl C to copy multi notes, Ctrl V to paste multi notes

✅ Tip: Press Ctrl V multiple times to continue pasting pattern

Multi Select or Hover over Music Object

Toggle Accent

Highlight multi notes or hover and press A

Toggle Staccato

Highlight multi notes or hover and press S

Toggle Tenuto

Highlight multi notes or hover and press D
Toggle Tie
Hover over note and press \textit{T} to join to adjacent note. Toggle \textit{Up/Down/Off}

Toggle Note Beaming
Hover over note and press \textit{Space} to add/remove beam to the adjacent note

Toggle Flipping Stems
Hover over note and press \textit{(F)} to flip stem up or down

\textbf{ +/- Dotted Note/Rest}
Highlight multi notes or hover and press period (.) repeatedly to increase or comma (,) to decrease

\textbf{ +/- Accidental Half Step}
Hover over note and press plus (+) repeatedly to increase or minus (-) to decrease

\textbf{ +/- Note/Rest Duration}
Highlight multi notes or hover and press right bracket (]) repeatedly to increase or left bracket ([) to decrease

\textbf{FILE DROPDOWN}

\begin{table}[h]
\centering
\begin{tabular}{|l|}
\hline
\textbf{Menu} \\
\hline
\text{New Composition} \\
\hline
\text{Save As} \\
\hline
\text{Open Composition} \\
\hline
\text{Options} \\
\hline
\text{Submit an Issue} \\
\hline
\text{Exit Music Jotter} \\
\hline
\end{tabular}
\end{table}

\textit{Navigate the settings dialog, create/save/open and exit Music Jotter}
The file dropdown menu can be accessed by clicking the File tab located on the ribbon.

✓ New Composition
✓ Save As
  o .jot (This is Music Jotter’s file extension)
  o .mid (Standard Midi File)
  o .xml (Save as an xml, which is useful if you wish to port into other music programs)
  o .pdf (Save a score to PDF, for printing)
✓ Open Composition
  o .jot (Opens Music Jotter’s file extension)
  o .mid (Opens a midi file)
  o .xml (Opens an xml file, which is useful if you wish to port from other music programs)
✓ Options
✓ Exit Music Jotter

CREATE A SCORE

You can create multiple documents in Music Jotter if you wish to do so. The following will outline the important attributes in creating a score.
The dialog box to create a new score

Time Signature

You may choose any valid time signature to display within your score. You can update your time signature at any time, and add other time signatures within the score as well.

Key Signature

You may choose any key signature to display within your score. You can update your key signature at any time, and add other key signatures within the score as well.
Number of Staves

Add the number of staves within your score. For example, if you wish to create a piano score, you will add 2 staves. A string quartet should contain 4 staves. This can be updated at any time, however you may not remove a staff unless all objects (notes, rests, dynamics) from that staff are deleted first.

Number of Measures

Add the number of measures to initially begin with. You can add/remove measures as you wish by left double clicking a measure to add, and right double clicking a measure to remove, however you may not remove a measure unless all objects (notes, rests, dynamics) from that measure are deleted first.

Stave Spacing

Initially set the default stave spacing in your score. As you set this, you can visually see what this spacing will look like. You may update this at any time, and this is encouraged, to help fix any layout mistakes that may arise.

Dynamic Score Formatting

If this box is checked, your score will automatically space notes and measures as you input notes and rests, and this leaves you with no control over your score output. However, if you wish to have more control, leave this box unchecked for a static layout. A static layout also has the added benefit of being smoother and faster when inputting notes.

Measures per Page

If you choose the static layout, you can enforce the number of measures per page here. You may increase/decrease the number of measures at any time by selecting a measure, and pressing the right or left arrow keys. Please note, that this will not increase the overall measures in your score, this just rearranges the measures visually.
Systems per Page

If you choose the static layout, you can enforce the systems per page here. In a piano piece, each system represents the right hand and left hand, which is normally grouped by a brace. So if you input 4 measures and 5 systems per page, your score will display 4 measures for each system, and 5 systems will make up the page. You may increase/decrease the number of systems at any time by selecting a measure, and pressing the up or down arrow keys.

Paper Size

Choose how you wish your score to look on paper.

Title of Piece

The name of your piece that will display at the top of your score. This can be updated at any time.

File Name

A file name is required before you start in order to take advantage of the networking features. Don’t worry, if you don’t wish to utilize our networking features, you can hide your score.

OPTIONS

Various options can be set in Music Jotter, and you can navigate to the options dialog by clicking on the file dropdown, and selecting Options. Upon clicking on Options a dialog box will be displayed and from there you can choose from various tabs.

Midi Ports

Select from a list of midi ports that are available to your system.
A list of midi ports available on the system

**Score Options**

4 sections are available here: Dynamic/Static, Antialiasing, Playback and Notes

Score options that affect your global settings
Dynamic/Static

Note Cursor

✓ A dynamic note cursor will convert your mouse cursor to how the note will look before inputted into the measure.
✓ A static note cursor will convert your mouse cursor to a static circular note head, which is better suited for slower computers or larger scores. Larger scores tend to lag.

Score Formatting

✓ A dynamic score will auto format your score as you enter notes and rests. When in this mode, you have no control over the score layout.
✓ A static score will not auto format your score as you enter notes and rests. You have complete control over the number of measures per system and systems per page. Select this option for faster note entry and an overall smoother experience if you are having issues with speed.

Antialiasing

Smooth Lines?

✓ Smooth lines make the score more visually appealing, however, this is more resource intensive. Also, parts are not enabled in this mode.
✓ Jagged lines don’t look as nice, however this mode allows for much faster note entry and score navigation. Parts are enabled, and PDF printing is still antialiased.

Playback

Cursor Type

✓ Colored Notes is selected by default, and highlight notes a light green color. Useful if seeing notation detail during playback is important.
✓ Play Bar will display a semitransparent red bar to play over the notes instead of highlights. Useful if seeing tempo change during playback is important.
**Mode**

✓ Real time playback instantly plays back your piece, but this can be an issue if memory is limited, sometimes causing popping sounds. If this is an issue, select:

✓ Buffered playback. The only drawback to buffered playback is that there is a slight delay when playing back a piece using this method.

**Scrolling**

Playback scrolls to the leftmost measure. Most of the time, leaving this checked is OK. But sometimes this can get tiresome and unnecessary if the playback occurs when the Booklet View mode is selected. If this is the case, uncheck the checkbox so that scrolling along the x-axis does not occur.

**Notes**

*Beam 8th Notes by*

✓ 4 notes

✓ 2 notes

**Miscellaneous**

✓ Enter notes in between other notes

✓ Auto spacing a measure while inputting notes or rests

✓ Moving the cursor while deleting notes

**Reset Config**

Resetting all global config values may sometimes be necessary, and if you do so, you will be asked to log into Music Jotter the next time you start the application. There may be an instance where you wish to install Music Jotter onto a new computer. If you do this, Music Jotter will not work, and you must contact the administrator shown on the dialog box to reactivate.
Reset your global configuration

**Key Shortcuts**

Key shortcuts are designed to help you navigate the software more effectively.

**LAYOUT TAB**

The Layout Tab contains the following groups:

**The layout tab responsible for your score layout**

**Selection**

The selection group is located on every tab.

**Zoom**

Either zoom in or zoom out of a score.
Object Select

When selecting this icon, your mouse icon changes to a blue dot. Hover over a note, grace note, rest, dynamic or text object and single click to edit properties. Left click to change the note pitch if a note, or to move the object if not a note. Right click to delete the object.

Measure Select

Click the Measure Select icon to either left or right click and drag a rubber band around music objects. You may also left click and select one or more measures at a time.

Pan Score

Click the Pan Score icon and left click to move the score around.

Views

There are 5 views; page view, booklet view, mixer view, history view and comment view. The score views change the way a score is presented (does not affect the pdf output). The mixer, history and comment views add windows to the main score.

Page View

View one page at a time, and navigate pages by clicking on the page number located right below the note entry toolbar. Note entry is fastest in this view and the score is less likely to lag.

Booklet View

View all pages at a time, and pan through the score or click on the page number located right below the note bar. Note entry is not as fast in this view if the score is large. If this is the case, click on Page View for a smoother user experience.

Mixer View

Toggle mixer view on/off.
History View

Toggle history view on/off.

Comment View

You can view comments to your score if you choose your score to be public. You may toggle this option on/off.

Layout

Global Stave Spacing

Clicking on this icon will change your mouse icon to a staff icon. Click and hold the left mouse button on your score, and drag your mouse up or down to change the global width of your stave spacing.

Global System Spacing

This works exactly like the global stave spacing, except the system spacing will update.

Measure & System Control

You can control the number of measures per system and systems per page. This is for static score layout only.

Add or Remove

+ / – Measures

You may increase or decrease the number of measures in your score.

+ / – Staves

You may increase or decrease the number of staves in your score.

Document Text

Text may either be the title of your score, document text, or lyrics.
Text/Lyrics

When selecting this icon, your mouse icon changes to a blue dot. Click anywhere on the score to enter text, which can be formatted to your liking. Alternatively, hover over a note and click in order to enter lyrics.

Score Title

The title of the score can be updated here.

Antialiasing

Jagged Lines

Render graphics quickly but with jagged lines. Output does not affect PDF export.

Smooth Lines

Render smoother graphics. Parts are not enabled in this mode and graphics may render more slowly.

EDIT TAB

The Edit Tab contains the following groups:

Tuples

Tuple Ratio

Tuplets are useful if you wish to input an irrational or irregular rhythm to your piece. Any tuple ratio may be added.
**Note Type**

**Normal Note**

Has a duration of whole note, half note, quarter note, 8th note, 16th note, 32nd note, 64th note or 128th note.

**Grace Note**

A smaller note used to indicate that it is melodically and harmonically nonessential. The grace note does not contain the normal duration of a normal note. For example, a whole note in 4/4 time takes the entire duration of the measure. But it is possible to include 1 or more grace notes in that measure, while it is impossible to add any extra normal notes in that measure, even tuples.

**Accidentals**

The accidentals indicate whether to raise or lower a note by a half step.

**No Sign**

A note that does not contain an accidental.

**Flat**

Decrease a note by a half step.

**Double Flat**

Decrease a note by two half steps.

**Natural**

Cancels the accidental assignment.

**Sharp**

Increases a note by a half step.

**Double Sharp**

Increases a note by two half steps.
Clef

Key & Time Signature

You may add a valid time and key signature anywhere within your score.

Change Clef

To add/change a clef, you must click on the change clef icon.

Retain Pitch

If this is left checked, the note pitch of that staff will remain unchanged, and the notes will transpose in order to maintain the current pitches. However, if this is unchecked, the notes will not transpose in the staff, however the pitches will be affected.

Cross Staff

You may wish to have notes (or musical phrases) located on the current staff to still belong to that staff, but to be displayed on the target staff (above or below) for readability purposes. Doing so does not affect the duration of the target staff and it also extends the stem of the note to the target staff.

Cross Staff Up

Right or left click and draw a rubber band around the notes you wish to highlight. Then click the Cross Staff Up icon.

Cross Staff Down

Right or left click and draw a rubber band around the notes you wish to highlight. Then click the Cross Staff Down icon.

Reset

Right or left click and draw a rubber band around the notes you wish to highlight. Then click the Reset icon in order to remove cross staff formatting on selected notes.
Parts

Visibility

The visibility of a part, either hidden, or colored.

**Hide**

If this mode is selected and you have multiple voices, the selected voice will be visible, while the rest of the voices will be hidden. Select (*) to unhide all voices.

**Colors**

If this mode is selected and you have multiple voices, the selected voice will be black, while the rest of the voices will be set to the color of their voice icon. Select (*) to unhide all voices. In this case, all voices will be set to black.

Voices

You may enter up to 5 voices in Music Jotter. Each voice can be edited separately by selecting the voice you wish to work with.

1-5 (*)

By default, all note entry is created on the first voice. If you want to add notes on a second voice, click on 2 and enter in your notes. Repeat this for 3-5 if you desire more voices.

Staff Groups

Staves can be grouped by either a brace or bracket. In piano pieces, it is common to group 2 staves with a brace. In orchestral works, it is common to group like instruments with the bracket.

Brace

First select a staff or staff range (selecting a staff, then press and hold Shift, then select another staff to complete the range). Click on the brace icon to group the staves.
Bracket

Same as above, but instead, click on the bracket icon to group the staves.

OPERATIONS TAB

The Operations Tab contains the following groups:

The operations tab responsible for actions that process or affect your score in any way

Copy & Paste

All operations that target copying and pasting elements.

Copy Tempo & Symbols Only?

This function only works when copying entire measures. Leave this unchecked if you wish to copy and paste all elements including notes and dynamics to the target measure. However, there may be an instance in which you may want to just copy tempo and symbol markings to another measure. If this is the case, check the checkbox and only tempo and symbol markings will be copied to the target measure.

Copy

There are two modes of Copy which will be described below. To clear out of Copy Mode, click anywhere on the score and the blue highlights will be eliminated.

Measure Copy

To copy a measure, click on the Measure Select icon and then click on the measure or measures you wish to copy. Either click on the icon Copy or
press \textit{Ctrl C} and the light yellow highlight will turn into a light blue highlight to indicate the measure or measures have been copied and stored into memory. At this point, Music Jotter is waiting for a \textit{Paste} action.

\textit{Partial Copy}

To copy partial notes or rests, click on the \textit{Measure Select} icon and then drag a rubber band around the groups of objects you wish to select. The objects will be highlighted red to indicate that the objects have been selected. Either click on the icon \textit{Copy} or press \textit{Ctrl C} and the objects will highlight blue to indicate that the objects are now copied and stored into memory. At this point, Music Jotter is waiting for a \textit{Paste} action.

\textbf{Paste}

There are two modes of \textit{Paste} which will be described below:

\textit{Measure Paste}

To paste a measure, after a measure has been copied select a target measure or multiple target measures and staves and click the icon \textit{Paste} or press \textit{Ctrl V}. If you decide to highlight multiple measures and staves by \textit{Shift Clicking}, Music Jotter will determine the pattern to paste in those selected measures and staves.

\textit{Partial Paste}

To paste partial notes or rests after the notes and rests have been copied, select a target measure and click the icon \textit{Paste} or press \textit{Ctrl V}. You may continue pasting the pattern as many times as you wish.

\textbf{Velocity \& Transpose}

\textbf{Update Velocity}

You may update \textit{note velocity} by either specifying the measure and stave range manually, selecting the measure and stave range within the score, or by highlighting the notes you wish to update.
Transpose Notes

There are several ways to transpose notes. You may transpose notes by either specifying the measure and stave range manually, selecting the measure and stave range within the score, highlighting the notes in which you wish to update, or by avoiding the dialog box all together and highlighting the notes you wish to update while pressing up or down.

Tempo

Master Tempo

If you click on the Master Tempo icon, a box will prompt you to enter in the beats per minute (bpm) of the score. This value affects the score globally, and can be updated in the Mixer as well.

Realistic Playback

If you click on the Realistic Playback icon, a dialog box will prompt you to select various settings that affect the playback of the score.

REPEATS & BARLINES TAB

The Repeats & Barlines Tab contains the following groups:

The barline/repeat tab is responsible for various types of repeats (Da Capo, Dal Segno) and other barline options

Simple Repeats

The Simple Repeats function is very simplistic, and handles both repeats and multiple endings.

✓  + / – Repeats (Repeats)
✓  + / – Repeats (Multiple Endings)
Special Repeats

Special Repeats are a little more complex, but Music Jotter aids you while creating these repeats. Furthermore, the documentation shows Implementation Diagrams which shows you step by step how to add a Da Capo or Dal Segno.

Da Capo

✓ Da Capo – Normal
✓ Da Capo al Fine
✓ Da Capo al Coda

Dal Segno

✓ Dal Segno – Normal
✓ Dal Segno al Fine
✓ Dal Segno al Coda

Clear All

You can clear your Da Capo or Dal Segno implementations by clicking on the Clear All icon.

Barlines

The only barline in this group that contains functionality is the End Bar. The End Bar will terminate a score. All barlines are toggled by clicking on a measure or a range of measures (by Shift Clicking) within a score, and by clicking the following icons in the ribbon:

✓ + / – No Bar
✓ + / – Thin Bar
✓ + / – Thick Bar
✓ + / – Double Thin Bar
✓ + / -End Bar

DYNAMICS TAB

The Dynamics Tab contains the following groups:
The dynamics tab is responsible for specialized dynamics that require you to click on the corresponding note or note range.

**Symbol Options**

Functions responsible for the following symbol options:

**Unhide Symbols**

When placing symbols on your score, the symbols by default will be visible. Visible symbols will be black.

**Hide Symbols**

When placing symbols on your score, the symbols by default will be hidden. Hidden symbols will be gray, but will not display when printing to pdf.

**Hide Hidden Symbols?**

If you do not wish to see the symbols that are hidden, check this checkbox.

**Symbol Alignment**

Align symbols by None, Staves, Brace or Bracket or Piano (middle of staff)

**Special**

These special dynamics can’t just be placed on the score directly. They require notes already placed on the score for user action, as described below (except in the instance of the last 2 symbols, the crescendo and diminuendo symbols)

**Arpeggio**

Click on any note in a chord and the arpeggio will automatically be built. An arpeggiated chord is a chord that is rolled with notes played in
rapid succession, usually in an ascending order with each note being sustained as the others are played.

**Mordent**

Click on a note to insert a mordent above that note. The mordent rapidly plays the principal note, the next higher note (according to key signature) then returns to the principal note for the remaining duration.

**Trill**

A ranged dynamic. Click on the first and last note to complete the trill. A rapid alternation occurs between the specified note and the next higher note (according to key signature).

**Turn**

Click on a note to insert a turn above that note. A sequence of an upper auxiliary note, the principal note, a lower auxiliary note, and a return to the principal note occurs.

**Up Slur**

A ranged dynamic. Click on the first and last note to complete the *up slur*. A slur is an indication to play two or more notes in an uninterrupted manner.

**Down Slur**

A ranged dynamic. Click on the first and last note to complete the *down slur*.

**Octava Alta**

A ranged dynamic. Click on the first and last note to complete the *octava alta*. Sets the transposition to +12 semitones starting from that symbol.

**Octava Bassa**

A ranged dynamic. Click on the first and last note to complete the *octava bassa*. Sets the transposition to -12 semitones starting from that symbol.
Accelerando

A ranged dynamic. Click on the first and last note to complete the *accelerando*. Increases the tempo progressively during the range.

Ritardando

A ranged dynamic. Click on the first and last note to complete the *ritardando*. Decreases the tempo progressively during the range.

Crescendo

A ranged dynamic. Click on the first and last note to complete the *crescendo*. Increases the velocity progressively during the range. Alternatively, you can input the crescendo symbol into the score which can be resized to span across multiple measures.

Diminuendo

A ranged dynamic. Click on the first and last note to complete the *diminuendo*. Decreases the velocity progressively during the range. Alternatively, you can input the diminuendo symbol into the score which can be resized to span across multiple measures.

NETWORK TAB

The Network Tab contains the following groups:

*The network tab focuses you on the social aspects of Music Jotter*
Music Jotter enables you to publish your score to be viewed, commented on and edited by others. Each version saved by you and other members will be added as another version that can be viewed by the community.

**View Score Versions**

Opens a dialog box that will display a list of your score versions.

**Score List**

Opens a dialog box that will display a list of the community’s scores, ordered by latest submission.

**Latest Comments**

Opens a dialog box that will display a list of the community’s scores, ordered by latest comments.

**Hide Piece?**

Check this checkbox if you do not wish to publish your piece for the community to view.

**MIXER**

The mixer can be optionally toggled by clicking on the *Mixer View* on the *Layout* tab.

*The layout tab responsible for your score layout.*

For more window real estate when composing your piece, it is advisable to hide the mixer window by clicking the *Mixer View* icon again, or by clicking on the small “x” at the top right hand corner of the mixer window.
The mixer controls various track settings, and enables you to add/edit instruments and channels to a track

**Master Controls**

The master controls are global controls that update the entire score’s attributes globally. It also displays the current measure, beat and page number of the score during *playback* or during *scrubbing*.

**Tempo**

The tempo can be updated in real-time while the score is playing by moving the slider. Furthermore, the global volume can be adjusted by clicking the space slightly below the slider bar. Let’s say you adjust the bpm for a piece from 132 at 100%, to 160 bpm. The tempo starting point has now changed, and 160 bpm is now at 100%.

**Volume**

This is the master volume of the entire score.

**Play/Stop/Scrub**

You can play your score here. The shortcut for toggling playback is *Space*. You can also scrub music as well. The shortcut for scrubbing music is *Z*. 
Track Controls

Each track in a score will have its own control. The control for a track is aimed at changing settings for that track specifically.

Volume

You can change the volume in real-time of the specific track by sliding the slider up and down.

Channel Panning

You can pan a channel in real-time to the left or right speaker by rotating the knob. The channel panning is good for creating stereo effects.

Mute

You can mute a track in real-time. You may want to mute a track if you wish to limit just one or two tracks in a large score. These settings also affect midi scrubbing.

Solo

You can solo a track in real-time. You may want to solo a track if you are composing a part. These settings also affect midi scrubbing.

Track Settings

There is an area right below the volume slider, indicated by #3 in the previous diagram, that you can click to bring up the track settings dialog. The track settings affect just that track.

Instruments

You may choose an instrument for playback in this section. You can choose up to 127 standard midi instruments, but if you have a sampler, these settings will be overridden.

Midi Channel

The midi channel can be selected here. Each midi channel can hold up to one unique instrument, and channel 10 is specifically dedicated to the
drumkit. You will hear the standard midi drumkit play back no matter what instrument is selected. Again, this can be overridden if you have a sampler.

Track Names

You may fill out a Long Track Name and/or a Short Track Name

✓ Long Track Name: This name is displayed on the first system only.
✓ Short Track Name: This name is displayed on all systems but the first.

MIDI SCRUBBING

Midi Scrubbing a score in Music Jotter is the process in which you left click on the playbar, and drag it across the score either forwards or backwards. The music will then play alongside with the cursor at the speed at which you drag the playbar.
Demonstrating a semi-transparent window overlapping a score during a midi scrubbing session

**Toggle the Midi Scrubbing Mode**

You can toggle the midi scrubbing mode either through its shortcut \textit{Z}, or by clicking on the \textit{Mixer View} on the Layout tab as shown below:
The layout tab responsible for your score layout

**Playbar**

The *playbar* is a visual cue representing the point at which the scrubbing will take place. The speed at which the playbar is dragged will affect the speed at which the music plays back. Furthermore, the notes that do play will highlight a light green color to alert you what notes are being played during the midi scrubbing session.

**Use Cases**

- ✓ If a user wishes to hear how a specific part of a measure sounds without necessarily playing back the piece in full.
- ✓ Clicking parts of a score instead of dragging the playbar to listen to chords, rather than melody.
- ✓ Useful to hear how a fast passage sounds without having to slow down the tempo on playback.

**HISTORY VIEW**

The history view dialog box can be made visible by clicking on the History View icon. You can undo various objects or operations in Music Jotter. This data is stored, and can be made visible by clicking on History View which can be toggled on/off. You may remove all undo history for the piece here by clicking on the X (see following image).
Music Jotter’s stored history

What Objects can be Undone?

Normal notes, grace notes, rests, dynamics, text and lyrics.

What Operations can be Undone?

Adding or subtracting measures, dots, accents, staccato, tenuto, duration, velocity and note pitch.

What is not Affected in an Undo?

Score layout, measure and stave width, key signatures and clefs.

Undo History Limits

Music Jotter supports unlimited undo history limits, unless you clear out the history by clicking on the “X”.
COMMENT VIEW

The comment view dialog box can be made visible by clicking on the Comment View icon. A piece can only be commented on if it is made visible.

Comments on the opened piece, if the piece is made visible

Real Time

Comments are viewed in real time, so if a user comments on your piece while you are composing, you will see the comment without having to close and reopen the score.

Character Limits

There is a 2000-character limit when writing comments.
Deleting Comments

If you are the owner of a comment, you may delete your comment by clicking on the “x” located at the top right of your comment.

Communicating with Users

The best way to communicate with a specific user is to click on his or her username and to send a message directly through Young Composers. The user will see that you messaged him or her directly within Music Jotter, since the message alert will activate. The notifications and alerts can be viewed real-time at the top right hand corner of Music Jotter.

MEASURE AND SYSTEM CONTROL

The measure & system control dialog box can be activated by clicking on the Measure & System Control icon. This is only effective if the score formatting is static. This can be changed in options.

Measures per Page

You can update the number of measures per system.
Systems per Page

You can update the number of systems per page

Scope

This Page

If This Page is selected, your selection will only be executed for the current page you are on.

All Pages

If All Pages are selected, your selection will be executed for your entire score.

ADD OR REMOVE MEASURES

The Add or Remove Measures dialog box can be activated by clicking on the Add or Remove Measures icon.

Dialog box to add or remove measures

Insert

You must make a selection before inserting a measure. Once your selection has been placed, you can insert x measures after the current selection.
You must make a selection before removing a measure. Once your selection has been placed, you can remove x measures after the current selection. You can only remove measures if all objects are deleted from those measures first.

ADD OR REMOVE STAVES

The *Add or Remove Staves* dialog box can be activated by clicking on the *Add or Remove Staves* icon.

![Add or Remove Staves dialog box](image)

*Dialog box to add or remove staves*

Insert

You must make a selection before inserting a staff. Once your selection has been placed, you can insert x staves after the current selection.

Remove

You must make a selection before removing a staff. Once your selection has been placed, you can remove x staves after the current selection. You can only remove staves if all objects are deleted from those staves first.
TUPLETS

Tuplets are useful if you wish to input an irrational or irregular rhythm to your piece. This becomes *convenient* to avoid constant time signature changes. This becomes *necessary* if two or more staves contain different irregular patterns. An example of this would be Chopin’s *Fantasie Impromptu Op. 66*, where the right hand plays regular 16th notes, and the left hand plays irregular eighth notes in the ratio of 3:2 in 4/4 time.

Tuplet entry in Music Jotter is simple. Once your tuple ratio is set, you simply compose your notes and Music Jotter automatically groups notes without the need for tuple reapplication. This saves an incredible amount of time if your piece uses tuples consistently throughout.

**Accessing the Tuplet Ratio Dialog**

To access the tuplet ratio dialog box, click on the *Edit* tab, then click on the *Tuplet Ratio* icon, as shown below:

*The edit tab responsible for all edit operations.*

The following dialog will appear:
The dialog box used to create a custom tuplet

The numerator will correspond to the number of notes that you would like to fit in the measure. The denominator represents the number of notes that normally fit into a measure of a time signature that you would like to replace.

**Tuplet Options**

You may choose to display the following to designate that a group of notes is a tuplet:

- **No Numbers**: If it becomes too tiresome to view a commonly used tuplet on a score, you may wish to remove the tuplet number altogether.
- **Numbers (No Brackets)**: Display a number without a bracket to represent the tuplet.
- **Numbers (Brackets)**: Display a number with a bracket to represent the tuplet.

To turn off tuplet note entry you must do so by checking the checkbox that is labeled *No Tuplets*. 
Common Tuplets

3:2
In 4/4 time, 3 notes will take the place of 2 notes. If 2 regular half notes fit into a measure, 3 irregular half notes now fit into the measure, due to this rule.

5:4
In 4/4 time, 5 notes will take the place of 4 notes. If 4 regular quarter notes fit into a measure, 5 irregular quarter notes now fit into the measure, due to this rule.

Uncommon Tuplets

7:4
In 4/4 time, 7 notes will take the place of 4 notes. If 4 regular quarter notes fit into a measure, 7 irregular quarter notes now fit into the measure due to this rule.

9:4
In 4/4 time, 9 notes will take the place of 4 notes. If 4 regular quarter notes fit into a measure, 9 irregular quarter notes now fit into the measure due to this rule.

13:8
In 4/4 time, 13 notes will take the place of 8 notes. If 8 regular eighth notes fit into a measure, 13 irregular eighth notes now fit into the measure due to this rule.

27:16
In 4/4 time, 27 notes will take the place of 16 notes. If 16 regular 16th notes fit into a measure, 27 irregular 16th notes now fit into the measure due to this rule.
TIME & KEY SIGNATURE

You may add a valid time and key signature anywhere within your score. The dialog box for this can be found on the edit tab:

The edit tab responsible for all edit operations.

With the measure selector, highlight the measure by clicking on it in order to add your time and key signature and click on the time and key signature icon in the ribbon. You may now update your time and key signatures in this dialog box and click “OK” to apply the changes. If you wish to remove a time signature or key signature, the best way to do this is to apply the time/key signature combination that you wish for that measure, and the program will sort it out for you.

The dialog box to create a time and key signature
ADDING A CLEF

To add a clef, you must click on the Change Clef icon on the edit tab. You can also decide if you wish to retain your note pitches by leaving the Retain Pitch? option checked, which will transpose your notes to the correct levels. If you uncheck this value, the notes will not transpose and the pitch values will be affected.

The edit tab responsible for all edit operations

After you select the Change Clef icon, your cursor will change to a tiny blue dot. This indicates that you are ready to click on a measure to insert the desired clef. Upon clicking, the target cursor will change to a red dot while the Choose a Clef dialog box opens.

This is the dialog box to use when adding a clef

From here, you can make your choice of a clef input. The most common clefs are to the left, separated by a line. The unpitched percussion clef is located at the far right. If you wish to transpose your clef, you can click on the up/down arrows where it says Transpose Octave. When you are ready to make your selection, click on a clef and you will be asked if you wish the clef to be placed at the beginning of the measure. If you click yes, it will,
otherwise the clef will be placed where the target red dot is (the point at which you clicked on the measure).

If you are not happy with the clef placement, you can hover over the clef, and right click to remove the clef, or you can left click and drag the clef if you wish to position it elsewhere within the measure.

**UPDATE VELOCITY**

You may update *Note Velocity* by either specifying the Measure and Stave range manually, selecting the measure and stave range within the score, or by highlighting the notes in which you wish to update. Either way, when you click on the *Update Velocity* icon from the *Operations Tab*, the dialog box will inform you on your selection.

*The operations tab responsible for actions that process or affect your score in any way*
Specify Measure/Staves

Updating note velocity

Manually Select Staves

You may manually select staves in the dialog box.

Manually Enter the Start Measure

You may choose the start measure here.

Manually Enter the End Measure

You may choose the end measure here.

Full Select Measures and Staves on Score

Alternatively, you can make a measure and stave selection within the score and the values will be updated in the dialog box.

Partial Selection

If you only wish to update a partial range of notes, you may select a partial selection with the rubber band, and the dialog box will inform you that the velocity update will now be applied to the current selection.
Velocity Value

The velocity value can be a value from 0 – 127.

Modes

Update all Values to (x)

You may update all note velocity values to a specific value.

Add/Subtract (x) to Current Values

Alternatively, you may apply an addition or subtraction update to all note velocity values. For example, if your note selections contain number values of 55, 65, 78 and 98 respectively, and you wish to increase the velocity by 20, the resulting notes will contain values of 75, 85, 98, and 118.

Updating Individual Notes

You can also update the velocity of individual notes by selecting the Object Select tool located on the Layout Tab.

The layout tab responsible for your score layout

Then when you hover over a note in your score, you can click that note to bring up the property dialog box for that note. You can update the velocity, as well as many other attributes as shown below:
The property dialog box for a note, where you can edit multiple note properties

TRANSPOSE NOTES

There are several ways to transpose notes. You may Transpose Notes by either specifying the measure and stave range manually, selecting the measure and stave range within the score, highlighting the notes in which you wish to update, or by avoiding the dialog box altogether and highlighting the notes you wish to update while pressing up or down. Either way, when you click on the Transpose Notes icon from the Operations Tab, the dialog box will inform you on your selection.
The operations tab responsible for actions that process or affect your score in any way.

**Specify Measure/Staves**

![Image of transpose dialog box]

**Updating note transposition**

**Manually Select Staves**

You may manually select staves in the dialog box.

**Manually Enter the Start Measure**

You may choose the start measure here.

**Manually Enter the End Measure**

You may choose the end measure here.

**Full Select Measures and Staves on Score**

Alternatively, you can make a measure and stave selection within the score and the values will be updated in the dialog box.
Partial Selection

If you only wish to update a partial range of notes, you may select a partial selection with the rubber band, and the dialog box will inform you that the transposition update will now be applied to the current selection.

Transpose Values

Half Steps

You may transpose a note or group of notes by any number of positive or negative *Half Steps*.

Whole Steps

You may transpose a note or group of notes by any number of positive or negative *Whole Steps*.

Octaves

You may transpose a note or group of notes by any number of positive or negative *Octaves*.

Shortcut

The shortcut to transpose notes (by half steps at a time only) is by partially selecting a group of notes and pressing the up or down arrow key. This is a convenient way to transpose notes quickly. However, if you need to transpose an entire score, it is easier to make your transposition through the dialog box since this method can handle half steps, whole steps and octaves. Furthermore, you can transpose by multiple steps, making this method more desirable in certain situations.

MASTER TEMPO

The *Master Tempo* can be updated from the *Operations Tab*, by clicking on the *Master Tempo* icon.
The operations tab responsible for actions that process or affect your score in any way

The dialog box will prompt you to enter beats per minute (bpm) which will affect the tempo of score globally. If you have tempo markings on your score, these markings will be updated accordingly as well, so you won’t have to update each marking individually.

Change the global tempo beats per minute (bpm)

You can also change the Master Tempo on the Mixer View by clicking on the area right below the tempo slider, as indicated in the following diagram.
Change the global tempo beats per minute (second location)

REALISTIC PLAYBACK

The Realistic Playback of the score can be updated from the Operations Tab, by clicking on the Realistic Playback icon.

The operations tab responsible for actions that process or affect your score in any way

Application

You can apply Realistic Playback to parts of your score, or to your score globally.
Realistic Playback creates a more human feel of your score playback. There are 4 metrics that can affect Realistic Playback.

Partial Selection

You may partially select notes by clicking on the Measure Select tool, and selecting notes with the rubber band. After you are happy with your selection, you can click on the Realistic Playback icon, and a message in red will notify you that you are Applying to selected notes. From here, you can adjust your settings and listen to your results. You may apply Realistic Playback to as many partial note selections and measure/stave selections as you wish.

Measure and Stave Selection

You may select a combination of measures and staves with the Measure Select tool by Shift Clicking measures and Staves. Then you must click on
the Realistic Playback icon, and a message in red will notify you that you are Applying to this selection. The dialog box will also display which staves and measure ranges will be affected. From here, you can adjust your settings and listen to your results. You may apply Realistic Playback to as many partial note selections and measure/stave selections as you wish.

Global Score

If you do not apply a partial selection or measure selection, and you just click on the Realistic Playback icon, a message in red will notify you that you are Applying Globally: Overwrite all. From here, you can adjust your settings and listen to your results. As the message indicates, your global settings will overwrite any partial note selections and measure/stave selections that you may have had.

Reset by Setting to Zero

You can reset all your playback settings if no notes or measures are selected and you set all values to zero (via the Master slider). You can also reset just specific metrics by setting those metrics to zero individually. A message will warn you that you will be Applying Globally: Overwrite all.

Realistic Playback Metric Values

There are 4 metrics and each metric takes in a value of 0 to 20. 0 indicates that realistic playback is off and you can turn this off at any time. 1 = very little randomness, and 20 = a high randomness.

Metrics

Master

Controls the tempo, velocity, attack and duration equally.

Tempo

Controls the randomness of the speed variation. The tempo changes will be relative to the values from the latest tempo marking in your score.
Velocity

Controls the randomness of the loudness of a note. The velocity changes will be relative to the values from any velocity dynamic markings and / or custom note velocity changes.

Attack

Controls the randomness of the starting time of a note.

Duration

Controls the randomness of the length of a note.

SIMPLE REPEATS

*Simple Repeats* in Music Jotter can be added from the *Repeats & Barlines Tab*.

The barline/repeat tab is responsible for various types of repeats (Da Capo, Dal Segno) and other barline options

**How to Add a Repeat**

Click on *Measure Select*, select a measure, then click on the +/- Repeat icon.

**Adding Multiple Repeats, Implementation Diagram**

To add multiple repeats, click on *Measure Select*, select a measure, then click on the +/- Repeat icon. Repeat this process as many times as you wish, and Music Jotter will automatically handle the correct matching repeat pair. See the example below on how to add 4 repeats to your score:

1. Click on the 2nd measure, then click the +/- Repeat icon.
2. Click on the 4th measure, then click the +/- Repeat icon.
3. Click on the 6th measure, then click the +/- Repeat icon.
4. Click on the 8th measure, then click the +/- Repeat icon.

Basic repeats in Music Jotter

Adding Ranged Repeats, Implementation Diagram

To add a ranged repeat, using the Measure Select tool, click on the starting measure, hold shift, and click on the ending measure. Then click on the +/- Repeat icon.

Ranged repeats in Music Jotter
Removing Repeats

To remove a repeat, click the measure that contains the repeat you wish to remove, then click on the +/- Repeat icon. Music Jotter will automatically remove the correct matching repeat pair.

MULTIPLE ENDINGS

Multiple Ending Repeats in Music Jotter can be added from the Repeats & Barlines Tab.

The barline/repeat tab is responsible for various types of repeats (Da Capo, Dal Segno) and other barline options

How to Add a Multiple Ending

Click on Measure Select, select a measure, then click on the +/- Repeat icon.

Adding Multiple Endings, Implementation Diagram

To add multiple endings, click on Measure Select, select a measure, then click on the +/- Repeat icon. To add another ending, click on the adjacent measure that contains the repeat and click on the +/- Repeat icon again. Repeat this process as many times as you wish, and Music Jotter will continue to add endings for you. See the example below on how to add 4 multiple endings to your score:

1. Click on the 2nd measure, then click the +/- Repeat icon.
2. Click on the 3rd measure, then click the +/- Repeat icon.
3. Click on the 4th measure, then click the +/- Repeat icon.
4. Click on the 5th measure, then click the +/- Repeat icon.
Multi Ending repeats in Music Jotter

Removing an Ending

To remove an ending, click the measure that contains the latest ending you wish to remove, then click on the +/- Repeat icon. Music Jotter will automatically remove the bracket and number pair for you. Please note, that you cannot remove an ending unless it is the latest ending. For example, Music Jotter will give you a warning if you try and remove ending 3 before ending 4. If for some reason Music Jotter does not remove all the graphics, you can manually remove the graphic by clicking on the Layout Tab and selecting the Object Select icon. Hover over the graphic until you see the hand icon, and right click to delete.

DA CAPO

*Da Capo* plays a piece up to the D.C. symbol, then jumps back to the beginning of the piece and repeats the piece one time until reaching the D.C. symbol again. *Da Capo* can be added to your score from the Repeats & Barlines Tab and by clicking on the Da Capo icon. You must now select the Normal mode. Instructions at the bottom of Music Jotter will aid you on the order in which to click on the measures for placement. But the following diagram will also aid you.

Selecting D.C. Normal

Click on the Da Capo icon and select mode Normal.
1. Select the measure to place D.C.

Plays until D.C., jumps to the beginning of the piece, then finishes the piece at D.C.

*Da Capo* is a simple repeat

**Removing Da Capo al Fine**

If you wish to remove *Da Capo* select the *Clear All* icon located under the *Special Repeats* group.

**DA CAPO AL FINE**

*Da Capo al Fine* plays a piece up to the D.C. al Fine symbol, then jumps back to the beginning of the piece and finishes at “Fine”. *Da Capo al Fine* can be added to your score from the *Repeats & Barlines Tab* and by clicking on the *Da Capo* icon. You must now select the *al Fine* mode. Instructions at the bottom of Music Jotter will aid you on the order in which to click on the measures for placement. But the following diagram will also aid you.

**Selecting D.C. al Fine**

Click on the *Da Capo* icon and select mode *al Fine*.

**Implementation Diagram**

1. Select the measure to place D.C. al Fine.
2. Select the measure to place the Fine.
Plays until D.C. al Fine, jumps to the beginning of the piece, and finishes at “Fine”

Removing Da Capo al Fine

If you wish to remove Da Capo al Fine select the Clear All icon located under the Special Repeats group.

DA CAPO AL CODA

Da Capo al Coda plays a piece up to the D.C. al Coda symbol, then jumps back to the beginning of the piece, looks for the Coda Flag then jumps to the Coda and finishes the piece at D.C. al Coda. Da Capo al Coda can be added to your score from the Repeats & Barlines Tab and by clicking on the Da Capo icon. You must now select the al Coda mode. Instructions at the bottom of Music Jotter will aid you on the order in which to click on the measures for placement. But the following diagram will also aid you.

Selecting D.C. al Coda

Click on the Da Capo icon and select mode al Coda.
Implementation Diagram

1. Select the measure to place D.C. al Coda.
2. Select the measure to place the Coda Flag.
3. Select the measure to place the Coda. The Coda plays until D.C. al Coda.

Plays until D.C. al Coda, jumps to the beginning of the piece, looks for the coda flag, jumps to the coda and finishes the piece at D.C al Coda
Removing Da Capo al Coda

If you wish to remove *Da Capo al Coda* select the *Clear All* icon located under the *Special Repeats* group.

**DAL SEGNO**

*Dal Segno* plays a piece up to the D.S. symbol, then jumps to the segno symbol, and repeats the piece one time until reaching the D.S. symbol again. *Dal Segno* can be added to your score from the *Repeats & Barlines Tab* and by clicking on the *Dal Segno* icon. You must now select the *Normal* mode. Instructions at the bottom of Music Jotter will aid you on the order in which to click on the measures for placement. But the following diagram will also aid you.

The barline/repeat tab is responsible for various types of repeats (*Da Capo, Dal Segno*) and other barline options

**Selecting D.S. Normal**

Click on the *Da Segno* icon and select mode *Normal*.

**Implementation Diagram**

1. Select the measure to place D.S.
2. Select the measure to place the Segno sign.
Plays until D.S., jumps to the segno symbol, and finishes the piece at D.S.

Removing Da Capo al Fine

If you wish to remove *Dal Segno* select the *Clear All* icon located under the *Special Repeats* group.

DAL SEGNO AL FINE

*Dal Segno al Fine* plays a piece up to the D.S. al Fine symbol, then jumps to the segno symbol and finishes at “Fine”. *Dal Segno al Fine* can be added to your score from the *Repeats & Barlines Tab* and by clicking on the *Dal Segno* icon. You must now select the *al Fine* mode. Instructions at the bottom of Music Jotter will aid you on the order in which to click on the measures for placement. But the following diagram will also aid you.

Selecting D.S. al Fine

Click on the *Dal Segno* icon and select mode *al Fine*. 
Implementation Diagram

1. Select the measure to place D.S. al Fine.
2. Select the measure to place the Segno sign.
3. Select the measure to place the Fine.

Plays until D.S. al Fine, jumps to the segno symbol, and finishes at “Fine”

Removing Dal Segno al Fine

If you wish to remove Dal Segno al Fine select the Clear All icon located under the Special Repeats group.
**DAL SEGNO AL CODA**

*Dal Segno al Coda* plays a piece up to the D.S. al Coda symbol, then jumps to the segno symbol, looks for the *Coda Flag* then jumps to the *Coda* and finishes the piece at D.S. al Coda. *Dal Segno al Coda* can be added to your score from the *Repeats & Barlines Tab* and by clicking on the *Dal Segno* icon. You must now select the *al Coda* mode. Instructions at the bottom of Music Jotter will aid you on the order in which to click on the measures for placement. But the following diagram will also aid you.

**Selecting D.S. al Coda**

Click on the *Dal Segno* icon and select mode *al Coda*.

**Implementation Diagram**

1. Select the measure to place D.S. al Coda.
2. Select the measure to place the Segno sign.
3. Select the measure to place the Coda Flag.
4. Select the measure to place the Coda. The Coda plays until D.S. al Coda.
Plays until D.S. al Coda, jumps to the segno symbol, looks for the coda flag, jumps to the coda and finishes the piece at D.S al Coda.

**Removing Dal Segno al Coda**

If you wish to remove *Dal Segno al Coda* select the *Clear All* icon located under the *Special Repeats* group.

**SYMBOL ALIGNMENT**

Music Jotter allows you to align a velocity symbol by *Staves, Brace or Bracket* or by a *Piano Staff*. To access the *Symbol Alignment* dialog box,
click on the *Symbol Alignment* icon located on the *Dynamics Tab* as shown below:

The dynamics tab is responsible for specialized dynamics that require you to click on the corresponding note or note range.

A dialog box will open with the following properties:

*Align symbols by Staves, Brace or Brackets, or by a Piano Staff*

None

Normally enter a dynamic that is not aligned.

Staves

Dynamics will be entered on all staves. This is very useful if you are composing an orchestra.
Brace or Bracket

Dynamics will be entered on the brace or bracket in which you enter the dynamic. This is useful if you wish to have certain dynamics based off of certain instrument groupings.

Piano (Middle of Staff)

If you are composing for a two staved instrument such as the piano, harpsichord, celesta, organ, etc., dynamics will be entered in the center of the two staves.

Symbols Already on the Score

You may align and/or expand a symbol already on the score by clicking on that symbol and choosing the desired symbol alignment action.

Example

An example will help you understand what Symbol Alignment is meant to achieve. Let’s say you wish to place a *forte* symbol (f) on all staves or just on staves that have a brace or bracket. This function allows you to achieve this seamlessly. Piano symbols are unique in that they normally are displayed in the center of the two staves. Music Jotter will automatically center the forte symbol if a symbol is aligned by a piano staff.

SCORE VERSIONS

If you want to open a specific version of your score, you must click on the *View Score Versions* icon on the *Network Tab*. 
The network tab focuses you on the social aspects of Music Jotter

File Versions

You may view all the versions of the currently opened .jot file. The following attributes of a file are displayed:

- File Name
- Composer
- Composer ID
- Date
- Version

The versions of your score which are saved to the network

Opening a File

You may open a file by double clicking on a version.
SCORE LIST

If you want to open other music compositions ordered by upload date from users of Music Jotter, you must click on the **Score List** icon on the **Network Tab**.

*The network tab focuses you on the social aspects of Music Jotter*

**File Names**

You may view all music compositions by other users of Music Jotter. The following attributes of a composition are displayed:

- ✔ File Name
- ✔ Composer
- ✔ Contributors
- ✔ Date
- ✔ # of Comments
The total list of scores submitted by users of Music Jotter, ordered by latest submission

**View File Versions**

You may view file versions by single clicking on a composition. From there you can open a specific file version by double clicking.

**Opening by Latest Comment**

You may also open up the score list by *Latest Comments* by clicking on the *Latest Comments* icon on the *Network Tab*. A nearly identical dialog box will open, with the latest compositions ordered by latest comments at the top.

**HIDE PIECE**

If you want to hide your piece from being seen by other users of Music Jotter, you must click on the checkbox *Hide Piece?* on the *Network Tab*. 
The network tab focuses you on the social aspects of Music Jotter

When you hide your piece, you ensure that your piece will not be displayed on the *Score List* for other members to see. You can change your decision to hide or unhide your piece at any time.